GigaDevice Semiconductor Inc.

Reference Manual for EtherCAT Protocol
Stack Code Porting

Application Note
AN246

Revision 1.2

( Sep. 2025)



e AN246
Reference Manual for EtherCAT Protocol Stack Code Porting

GigaDevice

Table of Contents

Table of CONtENtS .........ceeiiiiiiieieeeee e 2
List Of FIQUIres ... 3
= B 1= 1 o = 4
1. Preface...... . e nnnnas 5
2.  Generating Protocol Stack Code Using SSC TOOL.........ccccccummmmmmmmmmmmmmmmmnnnnnnnnns 6
3. Embedding Protocol Stack Code into the Project..........ccccccmrrmmmrmrininnninnnnnnnnns 1"
4. EEPROM Update Method .............oooiimmmmmiiiiisennn s 1
5. Methods for Adding SDO & PDO in COE ..o 14

5.1 AQAING SDO ...ttt h bt h e b et ah et b et eab e e sab e e e b e e e abeeeneeas 16

5.2 AddING PDO ...ttt ettt h e b et h e b et eb et b et eab e sabe e e b e e e abeeeneeas 20
6. ReVision history.........cc 27



€

AN246
Reference Manual for EtherCAT Protocol Stack Code Porting

GigaDevice
List of Figures
Figure 2-1. SSC Tool OPtions PAge.........cccciiriiiiiciimmirrrrisssssssmsessssssssssssssssssssssssssssssssssssssssssmsnssssessas 6
Figure 2-2. ConfiguratioNSPage..........ccccormmiiiiiiisicssmnrirer s ss s sssmss e s e s s s s s ssmn s e e s s e s s smnnn e e e s s snssssnmnnneenessas 7
Figure 2-3. Project Creation PAge ........cccccceiiiiiiicciiecirri s scssmsr e e e s s s s sssms s e s s s s smnnn s e e e s ss s smnnn e e e eenas 7
Figure 2-4. Select GD Project Page........cccccceiiiiicccimmiiriiisssscssesses e s s s s ssssss s s s s ss s smssns s s s s sssssssmnssssnssnas 8
Figure 2-5. Save Path Page ... ccsmsirn s sssms s s s e s s snms s e e mnmn e e e s s mmnn e e e e s 8
Figure 2-6. EXCEL File SeleCt Page ........ccccceiiiiicciieiiriiisssccssmnses s s s s ss s ssssss s s s s ss s smsnns s s s s snssssnmnssssnessas 9
[T LU T =Y A 14 ] o Yo o N - Ve - 9
Figure 2-8. Protocol Stack Code Generation Page........ccc.ccccevmmrmiimiisiccsscmrnnssnssssssssssees s e ss s s sssmnenes 10
Figure 2-9. Save Path Page ... st cses e s s s s smn e e s e e s s snmn e e e e e e s nmmmnn e 10
Figure 3-1. Source File DIirectory Page......ccccciiiccciimmiiiiiisscccsscrr s sssmsse s s s s s s s ssssne s e s s sssssssssmnssenees 11
Figure 3-2. Project Compilation Page ........cccciiiicccieciiiiiiccccceecrr s ssese e s e s s snmse e s e s s mnmne s ne s 11



c, AN246
Reference Manual for EtherCAT Protocol Stack Code Porting

List of Tables

Table 4-1. ReViSion RiStOry ... s s 27



€

GigaDevice

AN246
Reference Manual for EtherCAT Protocol Stack Code Porting

1.

Preface

This document is specifically designed for users of GD32 MCU products who need a
brief explanation of the steps and methods for porting EtherCAT protocol stack code.

This application note is divided into two parts: the first part describes the process of
generating protocol stack code using the SSC TOOL, and the second part explains th
e process of embedding and compiling the protocol stack code within a project.

Before using this application, users are required to be members of the ETG organizati
on in order to obtain access to the SSC TOOL for generating protocol stack code.
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2. Generating Protocol Stack Code Using SSC TOOL

Users must first complete the download of the SSC TOOL. Refer to the ETG official website
for download instructions:

https://www.ethercat.org/en/downloads/downloads 01DCC32A10294F2EA866F7E46FB028
5F.htm.

Refer to the following steps to generate protocol stack code:
1. Open the SSC Tool and select **Tool->Options™**.

Figure 2-1. SSC Tool Options Page

B Slave Stack Code Tool — O *

Fle  Project | Tool | Help
Show Conflict Window

| Options

EEPROM Programmer
Application 3

Conflicts

Failed to create a new slave project

2. Click on Configurations and select to add the configuration file GDESC_XXX_Config.xml.


https://www.ethercat.org/en/downloads/downloads_01DCC32A10294F2EA866F7E46FB0285F.htm
https://www.ethercat.org/en/downloads/downloads_01DCC32A10294F2EA866F7E46FB0285F.htm
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Figure 2-2. ConfigurationsPage

Generic Editor Create Files Confizwrations
e =
FC1100M4in8 or previous (x86)
FCU100/FC1121 | dByte T/0 Sanp
ELS500 | 8Bit Digital I/0, 16E. ..
ELOS00 | ZAxis Ciad02 Sample
EL9600 | Bootloader Sample
Import Configuration file(s) X
T~ » |EEfE » Data (D) » zzh » GDESC » GDESC2 » GDESC ~ O P
B - i - W @
GDESC L - s b
@ OneDrive 4] GDESC_CIA402 Config.xml 6 KB
e 4] GDESC_IO_Config.xml 7 KB
B EEMERErEE
= rEfE
§a0vEs
B 1
= B&
Fail el
¥ T
bhE=
W ==
2. Windows (C)
- Data (D:)
& e 4
IS (N): | GDESC IO _Configaml v| S5C Tool configuration file | v
FTFT0) L]

3. Create a new project in the SSC Tool by clicking **File->New**.

Figure 2-3. Project Creation Page

B Slave Stack Code Tool

File | Project Tool Help

E| ] Mew Ctrl+N |- Slave Settings
= Open  Ctrl+0O
Save Ctrl+5
Save As
Exit

Conflicts

Failed to create a new slave project
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4. Click on the **Custom** option, and select **GDESC IO configuration <GigaDevice

Semiconductor Inc  >** from the dropdown list.

Figure 2-4. Select GD Project Page

M TEE

Fle Projet Tool Help

- EtherCAT Slave

i 5laveInformation
-Generic
-Har dware

Zlave Settings
B.13
1.5.0.0

Version
-EtherCAT State Mac glave Stack Code Tool | New Project n -
- Symchroni sation 5.11
Application
B.11
Lo Fraocesslata O Default
; -Mallb]c-x (®) Custom | GDESC I0 configuration ¢Gigalevice Semiconductor Ined v 5.13
i Compiler
Yendor: Gigallevice Semiconductor Inc (0xFS2). A 5.12
YVersion: 1.0.0.0 5 11
HOTE: This configuration iz not provided by Beckhoff Automation and 5 12
files or file fragments may be added which are HOT covered by the )
licensze from Beckhoff futomation GmbH. B.12
B.13
B.13
B.13
N K
Import OE
¥ Into P Warning  &¥ Error
5. Save the project file and specify the save path.
Figure 2-5. Save Path Page
By GDESC 1O - Slave Stack Code Tool — O *
File | Project Tool Help
d Mew Ctrl+N Slave Settings
._? Open  Ctrl+0 S5C Version 513
Confiz File Vers1.5.0.0
A Save  Ctrl+S SEBE LG Ve
File name Description Version A
| Save As |ne
rer EtherCAT
Exit aoeappl. h .11
Mailbox applInterface h Ecatippl EtherCAT application B.13
Compiler ,
bootmode. o ESM EtherCaT State Machine 512
bootmode. b B 11
bootloaderappl. o Bootloader Bootloader Sample B 12
bootloaderappl. b 5.12
c1ad02appl. ¢ CiAd02appl CiA402 Sample Applicatien E.13
c1ad0Zappl. b B.13
coeappl. o CoE CANW Application Profile over EtherCAT 5.13 v
Add
Conflicts
€ Info A Warning &3 Error

Project "D:\zzh\GDESC\GDESC2\GDESC\GDESC 10.esp”saved
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6. Import the application EXCEL file, If the imported file is
GDESC_CIA402_Config_Demo.xml, this step can be skipped.

Figure 2-6. EXCEL File Select Page

B GDESC 10 - Slave Stack Code Tool - O *

Fle  Project | Tool | Help
Show Conflict Window

Options

0.0

EEPROM Programmer o

— Version A
therCAT 5 Application 4 Create new
vnchronis n-ru-n—_
@--Application aoeappl. b Import £ 11

wwProcessData
a1lbox applInterface h Ecatdppl EtherCAT application 513
Compiler .
bootmode. ESM EtherCAT State Machine B.12
bootmode. b E.11
bootloaderappl. o Bootleader Bootloader Sample 5.12
bootloaderappl. b B 12
c1ad0Zappl. o CiAd0Zappl Ci8d40Z Sample Application 513
ciad0Zappl. b 5.13
coeappl. ¢ CoE CAW Application Frofile over EtherCAT R.13 W
fdd
Conflicts
€ Info A\ Warning € Error
Project "Dizzh\GDESC\GDESC2\GDESC\GDESC 10.esp”saved
Figure 2-7. Import Page
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B EERERE=E
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B
= mH
B
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i, Windows (C)
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7. Protocol Stack Code Generation Page

Figure 2-8. Protocol Stack Code Generation Page

GDESC_IO - Slave Stack Code Tool = O x
File Tool Help
Find Setting Ctrl+F
LL“ Create new Slave Files F5 i
ETET 10 conrrg rrrevers] 5. 0.0
Har dware , File name Description Version A
EtherCAT State Machine »
Synehroni sation rey EtherCAT
A aoeappl. b E.11
applInterface b Ecathppl EtherCAT application E.13
bootmede. ¢ ESM EtherCAT State Machine B.1Z
bootmede. b 511
bootloaderappl. o FBootloader Bootloader Sample E. 12
bootloaderappl. b E. 12
c1adl2appl. ¢ CiA402appl CiA402 Sample Application E.13
c1ad02appl. b E.13
coeappl. ¢ CoE CAN Application Profile over EtherCAT .13 w
#dd
Conflicts
€ Info A Warning &3 Error
Project "D:\zzh\GDESC\GDESC2\GDESC\GDESC_IC.esp”saved
8. Select the path to save the protocol stack code and configuration XML file.
Figure 2-9. Save Path Page
~' Create new Slave Files n
File
m Froject File |D:%zzh\GDESCHGIESCZVGIESCHYGIESC_IO. esp
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Progress
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3.

Embedding Protocol Stack Code into the Project

1. Copy the generated protocol stack code to the EtherCAT/Src directory under the project
folder.

Figure 3-1. Source File Directory Page

orke » GDSCMB832XX » GDSCN832xx Demo Suites » GDSCNB32R_EVAL Demo_Suites » Projects » 01_EtherCAT_|O_SPI ’lEtherCAT » Src I
EfF =Sk it Fo

[ applinterface.h 2024/11/23 11:13 H 3o 6 KB
Q’ coeappl.c 202411723 11:13 C g 36 KB
[ coeapplh 2024/11/23 11:13 H 3o 4 KB
[ ecat_defh 2024/11/23 11:13 H 3ol 44 KB
[&f ecatappl.c 2024/11/23 11:13 C i 35KB
[&f ecatapplh 2024/11/23 11:13 H Zrif 6 KB
Q’ ecatcoe.c 2024/11/23 11:13 C =i 7 KB
Q’ ecatcoe.h 2024/11/23 11:13 H =i 5KB
[ ecatshv.c 2024/11/23 11413 C i 102 KB
[ ecatshv.h 2024/11/23 11413 H 3ol 31 KB
[&f esch 2024/11/23 11:13 H i 14 KB
[of Gpesc_i0.c 2024/11/23 11:13 C i 14 KB
Q’ GDESC_10.h 202411723 11:13 H i 2 KB
g GDESC_I0Objects.h 202411723 11:13 H 3o 13 KB
Q’ma”box.c 202411723 11:13 C g 38 KB
Q’ma”box.h 202411723 11:13 H 3o 9 KB
[ objdef.c 2024/11/23 11:13 C it 78 KB
[& objdefh 2024/11/23 11:13 H 3ol 15 KB
Q’ sdoserv.c 2024/11/23 11:13 C g 50 KB
Q’ sdoserv.h 2024/11/23 11:13 H =04 33 KB

2. Directly compile the project file.

Figure 3-2. Project Compilation Page

Diwork\GDSCNB32X00,GDSCNS3 2 Demo_Suites\GDSCNS32R_EVAL_Demo_Suites\Projects\01_EtherCAT_|10_SPI\MDK-ARM\GD32H75E_EVAL uvprojx - pVision
File Edit View Project Flash Debug Peripherals Tools SWCS Window Help

RN=} ﬂﬁ| dh —‘J.ﬂ‘ “) "“ o |.m %Eﬁ?’d’_ E ) f.l’f:|wtim:r_counter_\ralue_cona\‘p”@" ® O (5)"| E|'|

¥9 | cp3zH7sE_FvaL K| d= e 2
= A

B “t Project: GD32HTSE_EVAL
£1-§5 GD32HTSE_EVAL

-0 Application
L CMsIs
- GD32HTxx_Peripherals
@0 GD32HTxx
[ Startup
-0 GDESC_Hardware
@0 EtherCAT Stack
EHd Doc
& cmsis

EEPROM Update Method

The following steps illustrate how to update the EEPROM using the Twincat master software
as an example:

1. Copy the XML file to be updated into the designated directory of the Twincat software,
such as XXX\TwinCAT\3.1\Config\lo\EtherCAT directory.

1
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v > LEEEEE > Windows (C) » TwinCAT » 3.1 » Config » lo » EtherCAT

- teEsE &) GDESC_IO_HTOLaml
W =E
DYR
Share
¥
= B
EtherCAT
EXMC
gdesc
HTOL

™ OneDrive

£ EEREREEE
[ preEfE
BoEE

B w3

= BR

Y i

2. Open the TwinCAT software and click to open any project file.

bme » 1 x | [Eonld 25 i

8 TwinCAT 3 BE(]
2R Open
AT

Open Project/ Solution
FEmA

3 New TwinCAT Project...

TwinCAT test io.sin
ol 5

=
C:\Users\user6\Documents\TcXaeShel N TwinCAT te...

B ﬁ New Measurement Project...

G| GDESC:in

o C:\Users\user6\Documents\TcXaeShel \GDESC -

g8

AX TWINCAT.sIn z TwinCAT XAE Project (XML format) TwinCH

R Dozzhytwined )

TeXaeShell TwinCAT Me|

TwinCAT P

ol EEEERanE.

C:\Usershuse]

GDMOTOR:
bl

Dr\zzh\twinca|

o

3. After opening the project, click on Device, right-click and select Scan.

12
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T EEE
b MOTION
P PLC

1 SAFETY

EC++

& anavTics

ENERI(W). .. Ins

O ERETG)...
Add New Folder...

S ol

Exooct LAD Con
T

*§_ Scan

) Ctrl+V

Paste with Links

Shift+Alt+A

4. Select the corresponding network card connection. After successfully identifying the
slave device, check the corresponding network card and click OK.

=1
B setpos
A Trigger
all TWInCAT test io

[ c++
ANALYTICS

a
4

Aytomation Protocol)

2 new /O devices found

[Fieai

ek Ll GBE Famiy Cariraler]
A igab)

Cancel

Select Al

UnsslectAll

X

5. Click "Yes" consecutively until the scanning is complete.

e =
F [ svsTEM
b =] MOTION
b Bl P

4 saFeTY

B c++

& anawvmics
=L

b = Device 3 (EtherCAT)

&% Mappings

TcXaeShell

@ o

BN

13
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MOTION
[ ric
| SAFETY

(e
& anaLvmics
10
4 % Devices
2 Image
%% Image-Info
2 SyncUnits

Inputs
B Outputs
B InfoDat:
B Box 1 (GDESC_IO)
£ Box 2 (GDESC_IO)
# Box 3 (PO00000DO RFFFFFFFF)

vwv vl vew

PREOF, back t© TNIT].

) 2024/10/24 19:59:21 642 ms | 'Box 3 (PODD00000 RFFFFFFFF)’ (1003): 'INIT to PREOP" failed!

Error: 'check vendor id'. Comparison "0x7265746¢' == '0x00000004' failed
0NN ceas,

aborted

2024/10/24 19:59:21 642 ms | 'Box
(requested 'PREOP", back to 'INIT"),
) 2024/10/24 19:59:23 395 ms | 'Box
reached! Error: 'set device state to

TeXaeShell

eout (2000 ms)

@ 2024/10/24 19:59:23 395 ms | ‘Box —e—kthwt?ﬁ-emm led (requested
‘PREOP", back to 'INIT').
@ 2024710724 19:33:23 395 ms | Box cout (2000 ms)
reached! Error: 'set device state to
o 2024710724 19:59:23 395 ms | ‘Bex = ied (requested
"PREOP, back to "INIT).
(1003): 'INIT to PREOP" failed!

@ 2024710724 19:59:25 273 ms | Box
Error: ‘check vendor id'. Comparison '0x73736563' == '0x00000004' failed.
2024/10/24 19:58:25 273 ms | 'Box 3 (PODODO00D RFFFFFFFR)’ (1003): state change aborted
(requested 'PRECP', back to 'INIT).

@ 2024/10/24 19:59:27 026 ms | "Box 1 (GDESC_IO)" (1001): INIT to PREOP' fimeout (2000 ms)
reached! Error: 'set device state to INIT.

@ 2024710724 19:59:27 026 ms | 'Box 1 (GDESC I0) (1001T): state change aborted (requested
"PREOP", back to "INIT).

@ 2024710724 19:33:27 026 ms | ‘Box 2 (GDESC I0)' (1002): INIT to PREOP' fmeaut (2000 ms)
reached! Error: 'set device state to INIT.

@ 2024/10/24 19:59:27 026 ms | "Box 2 (GDESC_IO) (1002): stete change sborted (requested
"PREOP, back to "INIT).

After the scanning is complete, double-click on Device. The corresponding Box will

appear on the right side. Right-click on the Box and select EEPROM for updating.

el C

&l ANALYTICS

= 110

i % Devices

4 = Device 3 (EtherCAT)

%% image Number Box Name Address Type InSize  Out Size E-Bus (.
;' 'Sm:(gjr;::“’ E51 Box 1 (GDESC_IC) 1001 GDESC_IO 1.0 10
- I:puts [H] Box 2 (GDESC_I0) 1002 GDESC IO 1.0 10
L] Outputs SN —
@ InfoData

B8 Box 1 (GDESC_I0)
Box 2 (GDESC_I0)

# Box 3 (PO000D00O RFFFFFFFF)
&%, Mappings

FPGA Update...

Firmware Update...

Change Address...

Methods for Adding SDO & PDO in COE

Typically, we can choose two methods to add CoE object dictionary content:

One is to directly create a new object dictionary using the OD tool in the SSC Tool.

The other is to add new object dictionary content based on existing routines by modifying the

slave device XML file and the slave device program.

(AN_ET9300)

is the help documentation provided after installing the SSC Tool. This

document introduces the usage of the SSC Tool, which not only aids in learning how to use
the SSC Tool but also helps in understanding the processing flow of the slave protocol stack
code. It is very helpful in guiding how to add CoE dictionary content.

14
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B8 Slave Stack Code Tool — O X

File Project Tool | Help
Slave Project Navigation About... I

Contact

Documentation » ] AN_EL9800_V1i7
() Check for Updates - AN_ET9300 V1i10
AN_FC11x0x V1i5

EtherCAT Slave Design Quick Guide_V1i2

Online Development Documents

Conflicts

The first method is suitable for applications where the object dictionary is not extensively used
and the mapping is relatively simple. To add an object dictionary using the SSC TOOL, you
need to modify the Excel file (GDESC_10.xIsx) provided in the GD demo routine according to
the actual application. Then, re-import the file into the SSC TOOL to generate new protocol
stack code (refer to the steps in section 2.6 of this document). This will allow you to add the
corresponding object dictionary parameters. When adding the corresponding object dictionary,
pay attention to the arrangement order of the high byte and low byte in parameter naming to
ensure the naming complies with the standards.

Refer to sections 6.4 "Create an own Application" and 13 "OD Tool" in (AN_ET9300) to
edit the Excel file and add the required object dictionary content.

5001 Modular Device Profile Dange Notes: .
0 - The FDO mapping object sbiect dossn’t need 1o b eated auton 3
n - ing objects a v shall not be defin 1008, D100 a, 0rl0L0, DEl0L1,
o 4, OxleFL, o
equal o shall not. overlap byte bordars.
- Entries greater BBit shall alvays start at an exact vord border
The object dictionary defined here shall be used complementary with ETC.5001 and ETG. 1000
Index - ObjectCode - SI * DataType - Naas - Default ¥ - B/O/C - B/S - Access - rx/tx | CoeRead - Cos¥rite - Description
/ foxtaonz Input Data of the Nedule (OrA000 — OXGFFF)
0x600 RECORD Irputs
1 B00L B B ] T k3
2 B00L E k) ] 1o o m
ot Output Data of the Nodule (0x7000 - DxTFFE) /
0x7010 RECORD [
1EO0L i} ™ S
2oy 3 it 2
1/ 0xBrnx Configuration Data of the Nodule (0xBODO - Ox3FFF)
~—B8
{ foxtnz Infornation Data of the Nodule (0x9000 — OxSFFF)
Floshon Diagnosis Data of the Nodula (OxAOD — ORAFFF)
/o xxx Device Objects (02F000 = OxFFFF)
OxF 000 RECORD Nodular Device Profile ¥
1 UINT16 Index distance 0x10 ¥ o
2 DINT16 Naximum mumber of zedules r To

The second method, manually adding SDO & PDO, is suitable for more complex application
projects with extensive parameter mapping and mature applications. In such cases, manual
addition can be performed. When using the CIA402 routine, the configured xxx config.xml will
generate the corresponding code project. At this point, it is not supported to create a new
application by importing an Excel file. In other words, if you want to add new CoE objects to

15
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the CIA402 routine, you need to manually modify the XML and slave code based on the
existing foundation, as it cannot be done by editing and importing an Excel file.

When manually modifying, pay attention to the following: declare the relevant object dictionary
definitions and add them to the object dictionary; ensure consistency between code
modifications and XML modifications; if it involves PDO objects, you also need to modify the
definitions in the corresponding RxPDO and TxPDO and add objects to the PDO mapping.

5.1 Adding SDO

Taking the 23 _EtherCAT example of the GD32H75EY_EVAL board as an example, which
uses the CIA402 project, after completing the protocol stack porting and compilation based
on the above steps, a new set of parameters, Target Torque Value (0x6071) and Current
Actual Value (0x6078), needs to be added for communication purposes. The communication
is conducted using the SDO method.

1. Modify the XML file,
GDESC_CIA402.xml.

Add the corresponding object dictionary content in

<Object>
<Index>#x6871</Index>
<Name>Target Torque Value</Name>
<Type>INT</Type>
<BitSize»>16</BitSize>
<Info>
<SubItem:>
<Name>Target Torque Value</Name>
<Info>
<DefaultData>@</DefaultData>
</Info>
</SubItem>
</Info>
<Flags>

<Access
<Catego Category>
<PdoMapping>R</PdoMapping>
</Flags>
</0bject>

<0Object>
<Index>#x6@878</Index>
<Name>Current Actual Value</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Info>
<SubItem>
<Name>Current Actual Value</Name>
<Info>
<DefaultData»@</DefaultData>
</Info>
</SubItem>
</Info>
<Flags>

<Category>»o<
<PdoMapping>
</Flags>
</Object>

tegory>
/PdoMapping>

2. Modify the two files, cia402appl.h and cia402appl.c, in the protocol stack code.

First, modify cia402appl.c to add the code for initializing dictionary data values.

16
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case Bx6B6C:
pDiCEntry->pVarPtr = &localAxes[AxisCnt].0bjects.objvelocityActualValue;
break;

case @x6@71:
pDiCEntry->pVarPtr = &localAxes[AxisCnt].Objects.objTargetTorqueValue;
break;

case OxG077:
pDiCEntry-»pVarPtr = &localAxes[AxisCnt].0bjects.cbjTorqueActualvalue;
break;

case @x6@78:
pDiCEntry->pVarPtr = &localAxes[AxisCnt].0Objects.objCurrentActualValue;
break;

case Gx607A;
pDiCEntry-»pVarPtr = &localAxes[AxisCnt].0Objects.objTargetPosition;
break;

Then modify the cia402appl.h file to add specific dictionary declarations and definitions

in the structure.

typedef struct OBJ_STRUCT_PACKED_START

{
TOBJ168@ sRxPDOMap@;
TOBJ1681 sRxPDOMapl;
TOBJ1682 sRxPDOMap2;
TOBJ1AB8 sTxPDOMap@;
TOBJ1A®L sTxPDOMapl;
TOBJ1AB2 sTxPDOMap2; /

rief csv/csp RxPDO (@x1688)*/
rief csp RxPDO (@x1681)*/
\brief csv RxPDO (@x16@2)*/
rief csv/csp TxPDO (@x1A8@)*/
\brief csp TxPDO (@xlA@l)*/
\brief csv TxPDO (@Bx1A02)*/

UINT16 objErrorCode; | \
UINT16 objControlWord; < \brief Control
UINT16 objStatusWord; / wbrief Status Word (@x6@41)*/

INT16 objQuickStopOptionCode; /**< ‘brief Quick Stop Option Code (BxG85A)*/

INT16 objShutdownOptionCode; < \brief Shutdown Option Code (@x6@5B8)*/

INT16 objDisableOperationOptionCode; /**< \brief Disable Operation Option Code (Bx685C)*/

INT16 objHaltOptionCode; /**< \brief Halt Option Code (@x&@5D)*/

INT16 objFaultReactionCode; brief Fault Reaction Code (@x6@5E)*/

INT16 objMedesOfOperation; /* ief Modes of Operation (@x6@6@)*/

INT16 objMedesOfOperationDisplay; /**< ‘brief Mode of Operation Display (@x6@61)
INT32 objPositionDemandValue; /**< \brief Position Demand Value (Bx5@62)%*/
INT32 cbjPositicnActualInternalValue; < \brief Position Actual Internal Value (@x6863)%/

INT32 objPositionActualValue; /**< \brief Position Actual Value (Bx6@84)%/

UINT32 objFollowingErroriindow; /* \brief Following Error Window (@x6@65
UINT16 objFellowingErrorTimeQut; /**< ‘\brief Following Error Time Out (8xG866)%/
UINT32 objPositionWindow; /**< \brief Position Window (@x6@67)*/
UINT16 objPositionWindowTime; / \brief Position Window Time (@x&@68)*/

: & P i

TR T TP T PEPTIC TR PRRETAL

rief Error Code (@xG@3F)*/

INT16 objTargetTorqueValue; /**¢ \brief Target Torque Value (@x6071)%/
INT16 objTorqueActualvalue; /**< \brief Torque Actual Value (@x6877)%/
INT16 objCurrentActualValue; /**< \brief Current Actual Value (@x6878)*/

INT32 objHomeOffset; < rief Home Offset {ExEB?C)“'I
TOB16B7D objSoftwarePositionlimit; /**< ‘\brief Software Position limit (@x6870D)%/
UINT8 objInvertDir; /**< \brief Invert Dir (@x6@7E)*/
UINT32 objMaxPrefileVelocity; /**< ‘brief Max Profile Velocit
UINT32 objMaxMotorSpeed; /**< \brief Max Motor Speed (Bx6@88)*/
UINT32 cbjProfileVelocity; / \brief Profile Velocity (@x6881)%*/
UINT32 objProfileAcceleration; / \brief Profile Acceleration (@x6@883)*/
UINT32 objProfileDeceleration; /**< \brief Profile Deceleration (@xce@s4)*/
UINT32 objQuickStopDeclaration; / \brief Quick Stop Declaration (@x6@85)*/
INT8 objHomingMethod; /**< \brief Homing Method (@x6898)*/
TOBJ6@99 objHomingSpeeds; /* ief Homing Speeds(@x6839)*/
UINT32 objHomingAcceleration; /**< \brief Homing Acceleration (@x6@9A)*/
TOBJI6C2 objInterpolationTimePeriod; /**< ‘brief Interpolation Time Period (@x68C2)*/
INT32 objPosDemand; /**< \brief Pos Demand (@x6BFC)*/
INT32 objTargetVelocity; /**< \brief Target Velocity (@x68FF)*/
UINT32 objSupportedDriveModes; /**< \brief Supported Drive Modes (Bx6582)*/

(BxE@7F)*/

~

/** \brief Object @x686C (Velocity Actual Value) entry description®/
/** \brief Object @x686C (Velocity Actual Value) cbject name*/
0BICONST UCHAR OBIMEM aName@x6@06C[] = "Velocity Actual Value®;

/%% \brief Object 8x6871 (Target Torque Value) entry description®/
/%= \brief Object 0x6871 (Target Torque Value) object name*/

0BICONST UCHAR OBIMEM aName@x6871[] = "Target Torque Value";
/** \brief Object @x6877 (Torque Actual Value) entry description®/

/** \brief Object @x6877 (Torque Actual Value) object name*/
OBICONST UCHAR OBIMEM aName@x6877[] = "Torque Actual Value";

/** \brief Object @x6878 (Current actual value) entry description*/
/=* \brief Object @x6878 (Current actual value) object name*/
OBICONST UCHAR OBIMEM aName@x6678[] = "Current Actual Value";

}** \brief Object @x607A (Target Position) entry description*/

}** \brief Object @x687A (Target Position) object name*/
OBICONST UCHAR OBIMEM aName®x8G7A[] = "Target Position”;

OBICONST TSDOINFOENTRYDESC OBIMEM sEntryDesc®x606C = {DEFTYPE_INTEGER32, 0x20, (ACCESS_READ | OBJACCESS_TXPDOMAPPING)};

OBICONST TSDOINFOENTRYDESC OBIMEM sEntryDesc@x6871 = {DEFTYPE_INTEGER1G, @x1@, (ACCESS READWRITE | OBJACCESS RXPDOMAPPING)};

0BJCONST TSDOINFOENTRYDESC OBIMEM sEntryDesc@x6@77 = {DEFTYPE_INTEGERLE, ©x12, (ACCESS_READ | OBJACCESS_TXPDOMAPPING) };

OBICONST TSDOINFOENTRYDESC OBIMEM sEntryDesc@®x6878 = {DEFTYPE_INTEGER1S, ®x1@, (ACCESS_READ | OBJACCESS_TXPDOMAPPING)};

OBICONST TSDOINFOENTRYDESC OBIMEM sEntryDesc®x607A = {DEFTYPE_INTEGER32, 0x20, (ACCESS_READWRITE | OBJACCESS_RXPDOMAPPING)};

Set default values for parameters

17



GigaDevice

Reference Manual

AN246

for EtherCAT Protocol Stack Code Porting

3.

¥
zendif

0811600

Add new dictionary members to the dictionary

/* Object @x6868 */

/* Object @x6B6C */

{NULL,NULL, @x6@863, {DEFTYPE_UNSIGNED16 , @ | (OBJCODE_VAR << 8)}, &sEntryDescBx6@68, aName@x6868, NULL, NULL, NULL, @x@eed },

{NULL,NULL, ©x605C, {DEFTYPE INTEGER32 , @ | (OBICODE VAR << )}, &sEntryDescOx6@6C, aName@x5@5C, NULL, NULL, NULL, 0x0000 },

/* Object 8x6671 */

{MULL,NULL, @x6871, {DEFTYPE_INTEGER1E , @ | (OBJCODE_VAR << 8)}, &sEntryDesc@x6@71, aName@xG6@871, NULL, NULL, NULL, @x@00 },

[¥ phdact pucogg k/

SRR L et wirl II’ETVDF TNTW‘\E o | fORICONE WAR 231 Eﬁh—ul’\

/* Object @xee78 */

{NULL,NULL, @x6@878, {DEFTYPE_INTEGER16 , @ | (OBICODE VAR << 8)}, &sEntryDesc@x6678, aName®x6873, NULL, NULL, NULL, @x@ae@ },
T T

{NULL,NULL, @x667D, {DEFTYPE_INTEGER32 , 2 | (OBICODE_ARR << B)}, asEntryDesc@x6@7D, aName@x687D, NULL, NULL, NULL, @x@008 },

/* Object @x6@7A */

{NULL,NULL, @x6874, {DEFTYPE_INTEGER32 , © | (OBJICODE_VAR << 8)}, &sEntryDesc@x6@7A, aName®x6@7A, NULL, NULL, NULL, @x@pee },

The master writes 0x64 to 0x6071, and the corresponding objTargetTorqueValue in the
slave will receive the corresponding data. The user layer can read and call the

corresponding data structure to obtain the variable value.

General EtherCAT DC  ProcessData Pl Slots  Starup Cof - Online  Online
Update List [JAuto Update []Single Update []Show Offline Data
Advanced.. I |
Index Name Flags Value Unit

6066 Following Error Time Out RW 0x00000000 (0)

6067 Position Window RW 0x00000000 (0)

6068 Position Window Time RWP 0x0ADO (2560)
ROP 0
RWP Set Value Dialog X
RO P

6078 Current Actual Value RO P Des oK.

6074 Target Posttion RO P Hew 040054 Eore)

607C Home Offset RWP

+ 607D:0  Software Position Limit RO

607E Invert Dir RW

607F Max Profile Velocity RW P Book 0 1 Hex Edit.

6080 Max Motor Speed RW Biran: 5400 -

6081 Profile Velocity UL 01 08 @6 O O O

6083 Profile Acceleration RWP

6084 Prafile Deceleration RWP 0x00000000 (0)

6085 Quickstop Declaration RW 0

6008 Homing Method RW P 0
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<

@
L4
v
@
@
v
v
@
@

= Localfxes[0]

bAxislsActive 001 uchar
bBrakeApplied 001 uchar
blowLevelPowerpplied [0 uchar
bHighLevelPowerApplied 000 uchar
bAxisFunctionEnabled 0x00 uchar
bCenfigurationAllowed 001 uchar
1165tate 00002 ushort
uléPendingOptionCode w0000 ushort
fCurPosition o double
ud2CycleTime (0x 00000000 uint
=% 0:240008CC struct <untagged>
i sRxPDOMap0 0x240008CC struct <untagged>
1 % sRxPDOMap1 (0w 24000BE4 struct <untagged=
1 T sRxPDOMap2 (0x24000BF4 struct <untagged>
4 sKPDOMap0 0x24000C04 struct <untagged>
¥ sPDOMapl 0w 24000C1C struct <untagged>
5 sPDOMap2 0% 24000C2C struct <untagged>
# chjErrorCade %0000 ushort
# ohjControlWord 00000 ushort
¥ objStatusWord 1221 ushort
¥ objQuickStopOptionCode Ox0002 short
¥ objShutdewnOptionCode 0x0000 short
@ objDissbleOperationOptionC... (x0001 short
¢ objHaHOptionCode 0x0001 shart
@ ahiEaRatianCada mnanz ot

¥ ohjShutdewnOptionCode 0x0000 short

(Ox24000BB0 &tlocalAx... | struct <untagged>

@ objDisableOperationOptionC... 0x0001 short
¥ objHalOptionCode 0x0001 short
¥ objFaultReactionCode 0x0002 short
¥ objModesOfOperation Ox 0000 short
@ objModesOfCperationDisplay | (x0000 short
@ objPositionD: Val O D int
@ obj 0 int
¥ objPositionActualValue 0xD0000000 int
¥ objFollowingErerWindow Ox0ODOO0D0 wint
¥ objFollowingErrorTimeQut Ox 0000 ushort
@ objPositionWindow Ox00D00000 uint
@ objPositionWindowTime 0xDAD0 ushort
¥ _ohjVelocityActualValue (Ox 00000000 int
[ pra—
¥ objTorqueActualValue Ox00D0 shoit
¥ objCurrentActualValue Ox 000D short
¥ ohjTargetPosition 0=00000000 int
@ objHomeOffset 0x00000000 int o

For TX data that is read-only by the master, modifying the value of objCurrentActualValue

in the slave allows the master to read the data as well.

=]

T T TO O S T ST T T T

objModesOfOperationDisplay | Cx0000
objPositionDemandValue CeDO000D00
objPositionActuallnternalValue| 00000000
objPositionActualValue CeDO000D00
objFollowingErrorWindow O 00000000
objFellowingErrorlimeCut O D000

int
uint
ushort
uint
ushort
int
short
short

I;hl:nrt

objPositionWindow O 00000000
objPositionWindowTime O DADD
objVelocityActualValue O 00000000
objTargetTorqueValue CreD0B4
objTorqueActualValue (0000
objCurrentActualValue O D030
objTargetPosition O 00000000
objHomeOffset CeDO000D00
objSoftwarePositionLimit O 24000C80
objlnvertDir O D0
objMaxProfileVelocity O 00000000
objMaxMotorSpeed CeDO000D00
ohiProfileVelneitw The OODOONN0

int

int

struct <untagged=
uchar

uint

uint

uint
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6066 Following Error Time Out RW 000000000 (0)
6067 Position Window RW 0x00000000 (0)
6068 Position Window Time RW P 0x0AD0 (2560)
606C Velocity Actual Value ROP 0
6071 Target Torque Value RW P 100
6077 Torgue Actual Value RO P 0

(6078 Current Actual Value RO P 128 |
607A Target Pasition RO P 0
607C Home Offset RW P 0

= 6070:0 Software Position Limit RO =2 =
607E Invert Dir RW 0x00 (0)
607F Max Profile Velocity RW P 0x00000000 (0)
6080 Max Motor Speed RW 000000000 (0)
6081 Profile Velocity RW P 0x00000000 (0)
6083 Profile Acceleration RW P 0x00000000 (0)

5.2 Adding PDO

Similarly, using the 23_EtherCAT example of the GD32H75EY_EVAL board as a reference,
modify the XML and protocol stack code to add a set of parameters: Target Torque Value
(0x6071) and Current Actual Value (0x6078), using PDO communication mode.

First, complete the XML file modification by following the method for adding SDOs, add the
variables to the XML file, and then add the variables to the corresponding RXPDO and
TXPDO.

1. Add the corresponding indexes to the respective RXPDO (0x1600) and TXPDO
(0x1A00).

Add the corresponding indexes in DT1600.

<Name>DT16@8</Name>
<BitSize>168</BijtSize>

<SubItem>
<SubIdx>4</SubIdx>
<Name>SubIndex @84</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Bit0ffs>128</Bit0offs>
<Flags>
<Access>ro</Access>
<Category>o</Category>
</Flags>
</SubItem>

<Index>#x1600</ Indexs

spfcsvipp RxPDOC/ Names
o0/

cDefaultData>s</Defaulthatas
</Infor
</SubTtems

eSublndex @01+</Name>

cDefaultDatas 10084860 /Defaul thatas
</Tnfax

</SubTtem
<SubTtes

<Hame>SubIndex B2</Name>

DefaultData

< Defaulthata>

Name>SubIndex G83</Name>

<DefaultData>20007460< Defaul thata>

<Hame>SubTndex BB4</Name>
<Infos

Defaultbata>2000FFod</Defaul thata>

</Info>
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Add the corresponding indexes in DT1AQ0.

<BitSize>16

<SubItem>

<Flags>

</Flags>
</SubItem>

<Name>DT1A80</Name>

d/Bitsize>

<Subldx>5</SubIdx>
<Name>SubIndex @85</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<BitOffs>128</Bitoffs>

<Access>ro</Access>
<Category>o</Category>

<Tndex:#x1008¢/ Tndess
<Mame>csp/csv/pp TRPOOC Hame>
<Type>DT1A80</ Types
«<sitsizexasoc/Bitsizes

<Infes

<SubItems
<hame>SubIndex B0fc/Name>
<Infox
<DefaultDatas@s</DefaultDatas
</Infos
</SubTtem>
<SubItems
<Hame>SubIndex B0L</Names
<Info>
<Defaultoata>18084166</Defaul thatas
</Infes
</SubTtems
<Subltems
<MamesSubIndex BAZc/Names
<Infes
<DefaultDatar88086166</Defaul thatar
</Infor
</SubTtems
<SubItems
<MamesSubIndex @93 /Hame>
<Infox
<Defaultbatas 20006460/ Defaul thatas
</Infor
/SubTtems
<SubItems
<HamesSubIndex Bi4</Name>
<Infor
<DefaultDats>20006C68 </DefaultData>

Add the corresponding dictionary members in the required Module. In this example, add
them in "#x119800", and add the corresponding dictionary members in RX and TX.

<Entry>

<Entry>

</Entry>
<Entry>

</Entry>
<Entry>

<Type Moduleldent='#x119800 >Csv,Csp,pp - axis</lype>
<Name>dynamic switch bewteen csp/csv/pp</Name>
<RxPdo Fixed="true" Sm="2"»>
<Index DependOnSlot="true">#x16008</Index>
<Name>Qutputs</Name>

<Index DependOnSlot="truc">#x6848</Index>
<SubIndex>@</SubIndex>
<BitlLen>16</BitLen>

<Name>Control Word</Name>

<Comment>object @x684@:0</Comment>
<DataType>UINT</DataType>

</Entry>

<Index DependOnSlot="true">#x687A</Index>
<SubIndex>@</SubIndex>
<BitLen>32</BitLen>
<Name>TargetPosition</Name>
<Comment>object @x607A:0</Comment>
<DataType>DINT</DataType>

<Index DependOnSlot="true">#x68FF</Index>
<SubIndex>@</subIndex:>
<Bitlen»32</Bitlen>
<Name>TargetVelocity</Name>
<Commentrobject @x6OFF:@</Comments
<DataType>DINT</DataType>

<Index DependOnSlot="true">#x68FF</Index>
<SubIndex>@</SubIndex>
<BitLen>16</BitLen>

<JEn

<Name>TargetTorqueValue</Name>
<Comment>object @x66871:8</Comment>
<DataType>INT</DataType>
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<Index DependOnSlot="true">#x1a0@</Index>

<Name>Inputs</Name>

<Entry>
<Index DependOnSlot="true">#x60841</Index>
<SubIndex>@</SubIndex>
<Bitlen»16</Bitlen>
<Name>Status Word</Name>
<Commentrobject @x6@41:0</Comment>
<DataType>UINT</DataType>

</Entry>

<Entry>
<Index DependOnSlot="trus">#x6@64</Index>
<SubIndex>@</SubIndex>
<Bitlen>32</BitlLen>
<Name>ActualPesition</Name>
<Comment>object @x6@64:0</Comment>
<DataType>DINT</DataType>

</Entry>

<Entry>
<Index DependOnSlot="true">#x686C</Index>
<SubIndex>8</SubIndex>
<Bitlen>32</BitLen>
<Name>ActualVelocity</Name>
<Comment>object Bx6BEC:8</Commenty
<DataType>DINT</DataType>

</Entry>

<Entry>
<Index DependOnSlot="true">#x6877</Index>
<SubIndex>@</SubIndex>
<BitLen>16</BitLen>
<Name>TorqueActualValue</Name>
<Comment>ohject @x687|:8</Comment>
<DataType>INT</DataType>

</Entry>

Simultaneously add the corresponding dictionary to the Objects under the Dictionary in

the Module.

T
<Objects
<Index DependOnslot="true">#x6871</Index>
<Name>Target torque value</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Flags>
<Access>rw</Access>
<PdoMapping>r</PdoMapping>
</Flags>
</object>
<Object>

Thdex DependUnGlot="truc S Adex.
<Name>Torque actual value</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Flags>

<Access>ro</Access>
<PdoMapping>t</PdoMapping>
</Flags>
biocts

<Object>
<Index DependOnSlot="true">#x6675</Index>
<Name>Current actual value</Name>
<Type>INT</Type>
<BitSize>16¢/BitSize>
<Flags>
<Accessrro</Access>
<PdoMapping>t</PdaMapping>
</Flags>
</Object>
<Object>

Based on the code added above, continue to add code to support PDO access. First,
modify the cia402appl.c file.
Start by adding the data access code for the TXPDO's Current Actual Value (0x6078).
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void APPL_InputMapping(UINT16* pData)
UINT16 § = @;
UINT16 *pTmpData = (UINT16 *)pData;
UINTS AxisIndex;

for ( = 8; j < sTxPDOassign.ulSubIndexd; j++)

/*The Axis index is based on the PDO mapping et (@x10)*/
AxisIndex = ((sTxPDOassign.aEntries[§] & 8x78) >> 4);

suitch ((sTxPDOassign.aEntries[]& x0o0F))
case 0: //copy csp/csv TxPDO entries

“pTmpData++ = Localixes[AxisIndex].Objects.objStatusiiord;

*pTmpData++ = LocalAxes[AxisIndex].Objects.objPositionActualValue & oxF
#pTmpData++ = Localaxes[AxisIndex].Objects.objPositionActualvalues>l
*pTmpData++ = Localdxes[AxisIndex].Objects.objvelocityActualValue & ox
*pTmpData+t+ = LocalAxes[AxisIndex].Objects.objVelocityActualValue>»16;]

*pTwpData++ = LocalAxes[AxisIndex].Objects.objCurrentActualValue & @xFFFF;
*pTmpDatat+ = Localixes[AxisIndex].Objects.objrodesofOperationDisplay & oxFF;

break;
case 1://

{

csp TxPDO entries

Py

*pTmpData++ = Localixes[AxisIndex].Objects.objStatusiord;
*pTmpData++ = Localixes[AxisIndex].Objects.objPositionActualValue & oxF
*pTmpData++ = LocalAxes[AxisIndex].Objects.objPositionActualValue>»16;

copy csv TxPDO entries

*pTmpData++ = Localixes[AxisIndex].Objects.objStatusiord;
*pTmpData++ = Localixes[AxisIndex].Objects.objvelocityActualValue & oxF
=pTmpData++ = Localixes[AxisIndex].Objects.objVelocityhctualValue>>16;

break;
} //switch TXPDO entry

Then add the data access code for the RX's Target Torque Value (0x6071).

void APPL_OutputMapping(UINT16* pData)
UINT16 j = &;
UINT16 *pTmpData = (UINT16 *)pData;

UINTS AxisIndex;

for (j = ©; j < sRxPDOassign.ul6SubIndex@; j++)

{
/*The Axis index is based on the PDO mapping offs:
AxisIndex = ((sRxPDOassign.aEntries[j] & @xFo) >> 4);
switch ((sRxPDOassign.aEntries[j] & execer))
i
case @: v RxPDO entries
{
LocalAxes[AxisIndex].Objects.objContrelierd = SWAPWORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetPosition =SWAPKORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetPosition+=(SWAPWORD(*pTmpData++)<<l
LocalAxes[AxisIndex].Objects.objTargetVelocity =SWAPKORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetVelocity+=(SWAPWORD(*pTmpData++)<<16);
LocalAxes[AxisIndex].0bjects.objTarget TorqueValue =SWAPWORD(*pTmpData+t);
LocalAxes[AxisIndex].Objects.objModes0fOperation = SWAPWORD(*pTmpData++)&a:xfe;
}
break;
case //csp RxPDO entries
LocalAxes[AxisIndex].Objects.objContreliord = SWAPWORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetPosition =SWAPKORD(*pTmpData+t);
LocalAxes[AxisIndex].Objects.objTargetPosition+=(SWAPWORD(*pTmpData++)<<is);
}
break;
case 2: //csv RxPDO entries
{
LocalAxes[AxisIndex].0Objects.objControliord = SWAPWORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetVelocity =SWAPWORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetVelocity+=(SHAPWORD(*pTmpDatatt)<<l
}
break;
H
}

Modify the code in cia402appl.h.
Increase the number of entities.
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E Lo ot o ﬂn'-l'- [ PP alaa o =k +
typedef struct 0BI_STRUCT PACKED START {
UINT16 ulesSubIndex@; < \brief SubIndex @*/
UINT32  aEntries[6]; /**< \brief Entry buffer*/
} OBJ_STRUCT_PACKED_END
TOB]16@8;

‘\brief @x16@01 (csp RxPDO) data structur

typedef struct 0BJ_STRUCT PACKED_START {
UINT16 ul6SubIndex@ < \brief SubIndex &%/
UINT32  aEntries[3]; \brief Entry buffer*,

} OBJ_STRUCT_PACKED_END

TOBJI16@1;

‘\brief @x1682 (csv RxPDO) data structure*/
typedef struct 0BJ_STRUCT PACKED_START {
UINT16 ulsSubIndex@; < \brief SubIndex @*/
UINT32  aEntries[3]; \brief Entry buffer*,
1 OBJ_STRUCT_PACKED_END
TOBJ1le@2;

\brief @x1A88@ (csp/csv TxPDO) data structure*/
typedef struct 0BJ_STRUCT PACKED START {
UINT16 ul6SubIndex®; /**< ‘\brief SubIndex @*/
UINT32  aEntries[d]]; /**< \brief Entry buffer®/
1 OBJ_STRUCT_PACKED_END
TOBILlABE;

Add specific mapping member definitions.

/** \brief Data structure to handle the process data transmitted via @xL4@@ (csp/csv TxPDO)*/
typedef struct STRUCT PACKED_START

UINT16 ObjStatusWord; /**< \brief Status word (Bx6041)%/
INT32 ObjPositionActualValue; /**< \brief Actual position (@x6064)%/
. B . . f

G - =t t
I INT16 objCurrentActualValue; /**< \brief Current Actual Value (8x6878)%/ I
P T : g PETETIOTT 1/

7
}STRUCT_PACKED_END
TCiAdB2PDO1AGE;

/** \brief Data structure to handle the process data transmitted via @x1A81 (csp TxPDO)*/
typedef struct STRUCT_PACKED_START

UINT16 ObjStatusiord; /**< \brief Status word (8x6841)*/
INT32 ObjPositionActualValue; /**< \brief Actual position (@x6064)*/
UINT16 PaddingléBit; /**< \brief 16bit padding*/

}STRUCT_PACKED_END

TCiA4B2PDO1AG] ;

/** \brief Data structure to handle the process data transmitted via @x1A82 (csv TxPDO)*/
typedef struct STRUCT_PACKED_START
{

UINT16 ObjStatusWord; /**< \brief Status word (8x6041)*/
INT32 ObjPositionActualValue; /**< \brief Actual position (8x6084)%/
UINT16 PaddingléBit; /**< \brief 16bit padding*/

}STRUCT_PACKED_END

TCiA4B2PDO1AG2;

/%% \brief Data structure to handle the process data transmitted via @x168@ (csp/csv RxPDO)*/
typedef struct STRUCT_PACKED_START
{
UINT16 ObjControliord; /<< \b
INT32 ObjTargetPosition; /
) L g

rief Control word (@x684@)*/
ief Target position (8x6B7A)*/
e i ool

b

| INT16 objTargetTorqueValue; /**< \brief Target Torque Value (axsml)‘/l
TITTE 057 BEFECTONT 7 T OTTeT TouT o

}STRUCT_PACKED_END

TCiA4B2PDO1660;

e )

Add corresponding entity indexes.

\brief Object @x168@ (csp/csv RxPDO) entry descriptions

y
OBICONST TSDOINFOENTRYDESC OBJIMEM asEntryDescex16@8[] = {
{DEFTYPE_UNSIGNEDS, ©x8, ACCESS READ }, Subindex @80
{DEFTYPE_UNSIGNED32, ©x28, ACCESS_READ}, SubIndex @8
{DEFTYPE_UNSIGNED32, @x28, ACCESS_READ}, SubIndex 882
{DEFTYPE_UNSIGNED32, @x28, ACCESS READ}, SubIndex 88
{DEFTYPE_UNSIGNED32, ©x28, ACCESS READ}, SubIndex @8
{DEFTYPE_UNSIGNED32, @x28, ACCESS_READ}, /* SubIndex @@5*/
{DEFTYPE_UNSIGNED32, ©x28, ACCESS READ}}; /* SubIndex @@6*/
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* \brief Object @x1ABB (csp/csv TxPDD) entry descriptions

*/
0QBICONST TSDOINFOENTRYDESC OBIMEM asEntryDescexlAge[] = {
{DEFTYPE_UNSIGNEDS, @x8, ACCESS_READ }, /* Subindex @@@ */

{DEFTYPE_UNSIGNED32, @x2@, ACCESS READ}, /* SubIndex @@1°
{DEFTYPE_UNSIGNED32, @x2@, ACCESS READ}, SubIndex @@2°
{DEFTYPE_UNSIGNED32, @x2@, ACCESS_READ}, /* SubIndex @@3%/
{DEFTYPE_UNSIGNED32, @x2@, ACCESS READ}, /¥ SubIndex @@4%/
{DEFTYPE_UNSIGNED32, @x2@, ACCESS READ}, /* SubIndex @@s*/

{DEFTYPE_UNSIGNED32, @x2@, ACCESS READ}}; /* SubIndex 8od */

Add dictionary members to the corresponding mapping.

PROTO CiA4820bjects DefCiA4@20bjectValues
#ifdef _CiA482_
=1
» {6, {ex60400010,0x607APB20, BX6RFFOR2E,8x60710010,9X60600008 , 0xBA0RBE0S]) ], /* TOBJI16@8*/
{3, {@x6@460010,0x507AB020,0x00000010 }}, /*TOBI1G6B1*/
{3, {@x6@400010,Bx60FFE020,0x00000010 }}, /*TOBI16@2*/
> {5, {@x6e410016,0x60648020,0x606(0020,)px60750010, 8x60610008, 0x00000808}}, /*TOBILABE*/
coce 1

L L fETonoanon

Modify the number of members in the mapping of the CiA402 Axis dictionary.

*\brief Object dictionary related to on CiA482 Axis
=g
PROTO TOBJECT OBIMEM DefCiA482AxisObiDic[]
#ifdef CiAd@2
=1

/* Object exiees */

/* Object exieel */

/* Object @x1602 */

{NULL,NULL, @x16@2, {DEFTYPE_PDOMAPPING, 3 | (OBJCODE_REC << 8)}, asEntryDesc@x16@2, aName@x1682, NULL, NULL, NULL, @x@02e

/* Object @x1A00 */

{NULL,NULL, 8x1AB6, {DEFTYPE_PDOMAPPING, f| | (OBICODE_REC << 8)}, asEntryDesc@x1AB@, sName®x1AB8, NULL, NULL, NULL, @x668@
.

T

s1noa s

{NULL,NULL, @x16@@, {DEFTYPE_PDOMAPPING, 6 | (OBICODE_REC << 8)}, asEntryDesc@x160@, aName@x166@, NULL, NULL, NULL, @x@000

{NULL,NULL, @x16@1, {DEFTYPE_PDOMAPPING, 3 | (OBJCODE_REC << 8)}, asEntryDesc@x16@1, aName@x16@1,NULL, NULL, NULL, 8x@eed },

1
]

b
J

The master writes 0x64 through RXPDO (0x6071), and the corresponding
objTargetTorqueValue in the slave will receive the corresponding data. The user layer

can read and call the corresponding data structure to obtain the variable value.

@E-| -3 L=

Variable Flags Online

EERRSEEREESR(Crl) P~
4 [ VIsUs - Value: 100 ‘
i GlobalTextList
b L (PlcTask) Comment: object 0x6071:0
[ 255
4 O} GD_CSP Instance
3 PleTask Inputs
b [l PlcTask Outputs
[ sAFETY
B o+
& anavyTIcS Set Value Dialog %
« Evo
4 *L Devices | Dec ] o]
4 = Device 3 (EtherCAT)
. | Hex 00064 Cancel
9
2% Image-Info | Float | |
b 2 SyncUnits
3 Inputs 1
b W Outputs | Book [ 1 Hex Edt
4 B8 Drive 1 (GDESC_CIA402) 3l
4 B8 Module 1 (csw,csp,pp - axis) - BiSee @] @8 OB @2 @6 e

- Inputs

&1 Status Word

% ActualPosition

# ActualVelocity

# TorqueActualValue

# CurrentActualValue

# ModeOfOperationDisplay
4 W Outputs

= Control Word

W TargetPosition

TargetTorqueValue

%+ ModeOfOperation i

0 || Clear | &AL + Intellisense  ~
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= | Name
for (3 = 0; 3 < SRxPDOassign.uléSubIndex0; 3++) # LocalAxes|0].Objects.objTargetTorqueValue
! # LocalAxes{0].Objects.objCurrentActualValue | 0x0080
<Enter expression>

/*The Axis index is based on the PDO-mapping offsst. (0X10)%/
AxisIndex = ((sRxPDOassign.aEntries()] & OxFQ) >> 4);

switch . ((sRxPDOassign.aEntries (3] & O0x000F))

case 0: //csp/cav  RRPDO entries

»os s LocalAzes[AxisIndex].Objects.cbjConcrolWord = SWAPWORD (‘pTmpDatas++):
Localhxes[AxisIndex] .Objects.obiTargetPosition =SWAPWORD (*pTmpData+t) ;

Sh s LocalAxes[ARiaIndex].OBIects.oBITArgeTPoaLTions (SWAPWORD (*DTMpDATA++)<<16); &

Localhxes[AxisIndex] .Objects.obiTargetVelocity =SWAPWORD (*pTapData++) :

: et = (SWAFWORD (= <<ie)s
([ osaianes(amiatndex] +0b) ecks . cbiTargetTozquevaiue ~SWAPWORD (~pTmpDacars) 1]
o TR oD e T TTE—swIwoEDT *
Looa1AXe 3 [AXL3TAASR] OB 0T . GEIUGAR 0T - SWAPWORD (*PTWDDATa++) 6OXTE!
y—
breaks

LocalAxes(AxiaIndex] .ObIects. cBICONTIOINOTA = SWAPWORD (*PTMpDatas+)
Localhxes[AxisIndex] .Objects.obITargetPosition =SWAPWORD (*pTHpDATa++) :

6. For the TXPDO (0x6078) data that is read-only for the master, modifying the value of
objCurrentActualValue in the slave allows the master to read the data as well.

@00 ~ || Name Value
1371 /*The Axis andex 13 based on che.PDO:ma srtsec (ox1o) P e 006
it fisindex = ((#TxEROsssign. afatzies() & Gxo) =2 4 [ Locslaxesion Objects.objCurrentactuaivelue | ox0oe0 ]
1374 switen ((sTxPDOAssign.aEntriea(3]e Ox000F)) <Trter expression
1375 = {
1376 Gase.0: . //copy cap/cav TxPDO. encries
1377 [
1378 . *pTmpData+s = Localhxes(AxisIndex].Obiscts.obidracusWord:
1378 + s ——s*pImpData++ = LocalAxes [AxisIndex] .ObJjects.ocbjPositionActualValue & OXFFEF:
1380 *pTmpData++ = Locallhxes[AxisIndex].Objects.objPositionActualValues>16;
1381 s s —s —>"pTnpDaTa++ = LocalAxes [AxisIndex] .ObJects.obIVelocicyAcrualvalue & OXFFFF:
1382 s s s ——s*pInpData++ = LocalAxes[ ].0bjecta.obyvel 5161
1383 Py - [AxiaTodex) (Obiects opiT, MValue g OxFF
1394 (@ LocaLARes [AxiSINGSX] :0D)4<T 1 0DIC Lvalue % OXFTTT
1388 . T - o ok,
1386 y

@ E-[ e - o[ 2= Variable Flags Online

EIRER(Crl+) P -

&= visus - WValue: 128 ‘

] GDCSP

2[E GD_CSP.tmc

&dl GlobalTextlist

PlcTask (PlcTask) Comment: object Ox6078:0
&) mEEEE

4 O] GD_CSP Instance

New Value: Force Release

b PlcTask Inputs
> W PleTask Outputs
45| SAFETY
Cee
ANALYTICS
© e bevices D
4 =¥ Device 3 (EtherCAT)
%2 Image
*® Image-info
b 2 SyncUnits
3 Inputs
> Outputs
b [ InfoData
« [ Drive 1 (GDESC_CIA402)
a

B8 Module 1 (csv,csp,pp - axis)
- Inputs

& status Word

# ActualPosition

# Actualvelocity

¥ TorqueActualValue

43 CurrentActualValue
ModeOfOperation
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6. Revision history
Table 6-1. Revision history
Revision No. Description Date
1.0 Initial Release Apr.08 2025
11 1. Add EEPROM update method Jul.10.2025
1. Add methods for COE to include
1.2 Sep.8.2025
SDO & PDO.
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This
document, including any product of the Company described in this document (the “Product”), is owned by the Company
according to the laws of the People’s Republic of China and other applicable laws. The Company reserves all rights
under such laws and no Intellectual Property Rights are transferred (either wholly or partially) or licensed by the
Company (either expressly or impliedly) herein. The names and brands of third party referred thereto (if any) are the
property of their respective owner and referred to for identification purposes only.

To the maximum extent permitted by applicable law, the Company makes no representations or warranties of any
kind, express or implied, with regard to the merchantability and the fitness for a particular purpose of the Product, nor
does the Company assume any liability arising out of the application or use of any Product. Any information provided in
this document is provided only for reference purposes. It is the sole responsibility of the user of this document to
determine whether the Product is suitable and fit for its applications and products planned, and properly design, program,
and test the functionality and safety of its applications and products planned using the Product. The Product is designed,
developed, and/or manufactured for ordinary business, industrial, personal, and/or household applications only, and the
Product is not designed or intended for use in (i) safety critical applications such as weapons systems, nuclear facilities,
atomic energy controller, combustion controller, aeronautic or aerospace applications, traffic signal instruments,
pollution control or hazardous substance management; (ii) life-support systems, other medical equipment or systems
(including life support equipment and surgical implants); (iii) automotive applications or environments, including but not
limited to applications for active and passive safety of automobiles (regardless of front market or aftermarket), for
example, EPS, braking, ADAS (camera/fusion), EMS, TCU, BMS, BSG, TPMS, Airbag, Suspension, DMS, ICMS,
Domain, ESC, DCDC, e-clutch, advanced-lighting, etc.. Automobile herein means a vehicle propelled by a self-
contained motor, engine or the like, such as, without limitation, cars, trucks, motorcycles, electric cars, and other
transportation devices; and/or (iv) other uses where the failure of the device or the Product can reasonably be expected
to result in personal injury, death, or severe property or environmental damage (collectively "Unintended Uses").
Customers shall take any and all actions to ensure the Product meets the applicable laws and regulations. The Company
is not liable for, in whole or in part, and customers shall hereby release the Company as well as its suppliers and/or
distributors from, any claim, damage, or other liability arising from or related to all Unintended Uses of the Product.
Customers shall indemnify and hold the Company, and its officers, employees, subsidiaries, affiliates as well as its
suppliers and/or distributors harmless from and against all claims, costs, damages, and other liabilities, including claims
for personal injury or death, arising from or related to any Unintended Uses of the Product.

Information in this document is provided solely in connection with the Product. The Company reserves the right to
make changes, corrections, modifications or improvements to this document and the Product described herein at any
time without notice. The Company shall have no responsibility whatsoever for conflicts or incompatibilities arising from
future changes to them. Information in this document supersedes and replaces information previously supplied in any

prior versions of this document.

© 2025 GigaDevice Semiconductor Inc. — All rights reserved

28



	Table of Contents
	List of Figures
	List of Tables
	1. Preface
	2. Generating Protocol Stack Code Using SSC TOOL
	3. Embedding Protocol Stack Code into the Project
	4. EEPROM Update Method
	5. Methods for Adding SDO & PDO in COE
	5.1 Adding SDO
	5.2 Adding PDO

	6. Revision history

